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About This Guide
This document describes the installation and initial configuration of the Extreme Networks Extreme
Management Center NMS-A-305 hardware engine.

This document is intended for experienced network administrators who are responsible for
implementing and maintaining communications networks.

Text Conventions
The following tables list text conventions that are used throughout this guide.

Table 1: Notice Icons
Icon Notice Type Alerts you to...

General Notice Helpful tips and notices for using the product.

Note Important features or instructions.

Caution Risk of personal injury, system damage, or loss of data.

Warning Risk of severe personal injury.

New This command or section is new for this release.

Table 2: Text Conventions
Convention Description

Screen displays This typeface indicates command syntax, or represents information as it appears on the
screen.

The words enter and
type

When you see the word “enter” in this guide, you must type something, and then press
the Return or Enter key. Do not press the Return or Enter key when an instruction
simply says “type.”

[Key] names Key names are written with brackets, such as [Return] or [Esc]. If you must press two
or more keys simultaneously, the key names are linked with a plus sign (+). Example:
Press [Ctrl]+[Alt]+[Del]

Words in italicized type Italics emphasize a point or denote new terms at the place where they are defined in
the text. Italics are also used when referring to publication titles.

Extreme Management Center® NMS-A-305 Installation Guide 4



Related Publications

Extreme Management Center™ Documentation
Extreme Management Center (EMC, formerly NetSight) documentation, including release notes, are
available at: http://documentation.extremenetworks.com.

Extreme Management Center online help is available by clicking the ? icon in all EMC pages. The online
help provides detailed explanations of how to configure and manage your network using EMC.

For complete regulatory compliance and safety information, refer to the document Intel® Server
Products Product Safety and Regulatory Compliance.

Getting Help
If you require assistance, contact Extreme Networks using one of the following methods:

• GTAC (Global Technical Assistance Center) for Immediate Support

• Phone: 1-800-998-2408 (toll-free in U.S. and Canada) or +1 408-579-2826. For the support
phone number in your country, visit: www.extremenetworks.com/support/contact

• Email: support@extremenetworks.com. To expedite your message, enter the product name or
model number in the subject line.

• GTAC Knowledge — Get on-demand and tested resolutions from the GTAC Knowledgebase, or
create a help case if you need more guidance.

• The Hub — A forum for Extreme customers to connect with one another, get questions answered,
share ideas and feedback, and get problems solved. This community is monitored by Extreme
Networks employees, but is not intended to replace specific guidance from GTAC.

• Support Portal — Manage cases, downloads, service contracts, product licensing, and training and
certifications.

Before contacting Extreme Networks for technical support, have the following information ready:

• Your Extreme Networks service contract number and/or serial numbers for all involved Extreme
Networks products

• A description of the failure

• A description of any action(s) already taken to resolve the problem

• A description of your network environment (such as layout, cable type, other relevant environmental
information)

• Network load at the time of trouble (if known)

• The device history (for example, if you have returned the device before, or if this is a recurring
problem)

• Any related RMA (Return Material Authorization) numbers

Providing Feedback to Us
We are always striving to improve our documentation and help you work better, so we want to hear
from you! We welcome all feedback but especially want to know about:

• Content errors or confusing or conflicting information.

About This Guide
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• Ideas for improvements to our documentation so you can find the information you need faster.

• Broken links or usability issues.

If you would like to provide feedback to the Extreme Networks Information Development team about
this document, please contact us using our short online feedback form. You can also email us directly at 
internalinfodev@extremenetworks.com.

About This Guide
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1 Engine Overview and Setup

Kit Contents
Specifications
Front Panel Features
Back Panel Features
Removing and Installing the Front Bezel
Installing the Engine into a Rack

This chapter lists the components shipped with the NMS-A-305 engine, describes the front and back
panels, and provides information on engine specifications.

For complete regulatory compliance and safety information, refer to the document Intel® Server
Products Product Safety and Regulatory Compliance, available at the following links:

http://download.intel.com/support/motherboards/server/sb/g23122003_safetyregulatory.pdf

http://www.extremenetworks.com/support/documentation/

Kit Contents
The NMS-A-305 engine ships with the following components:

• Extreme Networks URL card

• Front bezel label

• A rack mounting kit

• Two rack handles and appropriate screws

• AC power cord bracket and cable clamp kit

• One USB flash drive

Specifications
The physical specifications for the engine are listed in Table 3. The environmental requirements are
listed in Table 4 on page 8.

Table 3: NMS-A-305 Physical
Specifications
Processor

Processor type NMS-A-305 - Intel® Xeon® E5-2620 v4 processor

Processor speed 2.1 GHz

CPU Cores 8

Memory

Architecture 2400 MHz Dual Ranked Registered (RDIMM) ECC DDR4
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Table 3: NMS-A-305 Physical
Specifications (continued)
Memory module capacities 4 GB DIMMs

Minimum RAM (included) 64 GB (sixteen 4 GB DIMMs)

Maximum RAM 128 GB (thirty-two 4 GB RDIMMs)

RAID Configuration RAID 1 with BBU

Drives

Hard drives One 960 GB SSD hard drive

Connectors

Back

NIC Four RJ-45

Serial 9-pin, DTE, 16550-compatible

USB Three 4-pin, USB 2.0-compliant

Video 15-pin VGA

Networking Two 1 GB Ethernet

Front

USB Two 4-pin, USB 2.0-compliant

Video 15-pin VGA

Power

AC power supply (per power supply) Redundant power supply

Wattage 750 watts

Input voltage • 90 – 132 V at 47/63 Hz 8.2 A

• 180 – 264 V at 47/63 Hz 4.4 A

Output voltage • 62.0A at 12 V

• 2.1A at 12 VSB

Physical

Height 4.45 cm (1.72 in.)

Width 43.0 cm (16.93 in.)

Depth 70.99 cm (27.95 in.)

Weight (maximum configuration) 13.15 kg (29 lb.)

Table 4: NMS-A-305 Environmental Specifications
Parameter Limits

Operating temperature +10°C (+50°F) to +35°C (+95°F) with the maximum rate of change
not to exceed 10°C (+50°F) per hour

Storage temperature -40°C (-40°F) to +70°C (+158°F)

Storage humidity 50% to 90%, non-condensing at 28°C (82°F)

Engine Overview and Setup
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Table 4: NMS-A-305 Environmental Specifications (continued)
Parameter Limits

Vibration, unpackaged 5 Hz to 500 Hz, 2.20 g RMS random

Shock, operating Half sine, 2 g-force peak, 11 milliseconds

Shock, unpackaged Trapezoidal, 25 g, velocity change 136 inches/second (40 lb to < 80
lb)

Shock, packaged Non-palletized free fall in height 24 inches (40 lb to < 80 lb)

ESD ±12 KV except I/O port ±8 KV per Intel® Environmental test
specification

Estimated thermal dissipation 1550 BTU/Hr

Front Panel Features
The following figure shows the NMS-A-305 engine front panel features. Figure 2 on page 9 shows the
front control panel.

Figure 1: NMS-A-305 Front Panel Features

A System label pull-out D Front control panel (see Figure 2 on page 9)

B Video Connector E Hard disk drive bays

C USB 3.0 Ports

Figure 2: Front Control Panel

A System ID button w/integrated LED F System status LED

B NMI button (recessed, tool required for use) G Power button w/integrated LED

C Mgmt port activity LED H Hard drive activity LED

Engine Overview and Setup
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D Not used I Not used

E System cold reset button J Not used

Hard Drive LED Indicator Patterns
The hard drive has two LED indicators visible from the front of the system: one is a green LED for disk
activity, and the other is amber and indicates hard drive status. The LEDs have the following states, as
described in Table 5.

Table 5: Hard Drive Activity LED Indicator Patterns
Hard Drive Condition Activity LED Patterns

Power on and drive spinning up or spinning down Off

Power on with drive activity Blinking green

Table 6: Hard Drive Status LED Indicator Patterns
Hard Drive Condition Status LED Patterns

No access or no fault Off

Hard drive fault has occurred Solid amber

Back Panel Features
Figure 3 shows the NMS-A-305 engine back panel.

Figure 3: NMS-A-305 Back Panel

A Power supply module #1 F Serial port

B Power supply module #2 G USB 2.0 ports

C eth0 H Mgmt port, out of band

D eth1 I I/O Module Bay

E Video connector J Riser cards, not used

Table 7 describes the LEDs for the RJ45 management port.

Engine Overview and Setup
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Table 7: RJ45 Port LEDs (Management Port)
LED Type LED Pattern Status Indication

Network speed (right) Off 10 Mbps

Amber 100 Mbps

Green 1000 Mbps

Link activity (left) Off No link

Solid Green Active link

Blinking Green Data traffic activity

Power Supply Status Indicator Patterns
The engine has two power supplies, supplying hot-pluggable power redundancy. The system distributes
the power load across both power supplies to maximize efficiency.

Each power supply has a single bi-color LED to indicate power supply status, as described in Table 8.

Table 8: Power Supply Status LED Indicator Patterns
LED Pattern Power Supply Condition

Green Output on and OK

Off No AC power to all power supplies

1Hz blinking green AC present / Only 12VSB on (PS off) or PS in cold redundant state

Amber AC power cord unplugged or AC power lost. With a 2nd PS in parallel still with AC input
power

1Hz blinking amber Power supply warning events where PS continues to operate — high temp, high power,
high current, slow fan

Amber Power supply critical event causing a shutdown, failure, OCP, OVP, fan fail

2Hz blinking green Power supply firmware updating

Removing and Installing the Front Bezel
The NMS-A-305 engine comes with an optional front panel bezel that can be attached to the front of
the chassis by snapping the bezel onto the chassis handles. A key lock allows you to lock the bezel in
place so that front panel controls cannot be used. You can still monitor system status indicators with the
bezel in place.

Removing the Front Bezel
To remove the front bezel:

1 Unlock the bezel if it is locked.

2 Remove the left end of the front bezel from rack handle.

Engine Overview and Setup
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3 Rotate the front bezel counterclockwise to release the latches on the right end from the rack handle.

Installing the Front Bezel

Note
Before installing the bezel, you must install the rack handles. See Installing the Engine into a
Rack on page 12.

To install the front bezel:

1 Lock the right end of the front bezel to the rack handle.

2 Rotate the front bezel clockwise till the left end clicks into place.

3 Lock the bezel, if needed.

Installing the Engine into a Rack
A rack mounting kit and installation guide are included with the NMS-A-305 engine. The rack mounting
kit allows you to install the engine into a four-post rack cabinet. Refer to the installation guide for
complete installation instructions.

If you are table mounting the engine, ensure at least 6 cm of clearance on all sides of the engine for
proper ventilation.

If you are installing the engine in a rack:

1 Install the rack handles by aligning a rack handle with the two holes on each side of the engine and
attaching each handle to the engine with two screws as shown in Figure 4.

Figure 4: Installing the Rack Handles

2 Read the installation guide included with the rack mounting kit.

3 Install the rails and mount the controller in the rack as instructed.

Torque Values
Table 9 describes the recommended torque values to use when installing the engine using standard
threaded fastener machine screws and bolts.

Engine Overview and Setup
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Table 9: Recommended Torque Values by Screw Size
Screw Size Torque in Pounds Bit Size

English Metric -%5 Nominal +%5

N/A N/A 1.42 1.5 1.57 0

2 – 56 1.5 2.85 3.0 3.15 0

4 – 40 2.5 4.75 5.0 5.25 0/1

6 – 32 3.5 8.55 9.0 9.45 1

8 – 32 4.5 17.10 18.0 18.90 2

10 – 32 5 30.40 32.0 33.60 2

1/4 – 20 6.5 63.65 67.0 70.35 3

Engine Overview and Setup
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2 Configuration

Pre-Configuration Tasks
Configuring the Engine
Launching Extreme Management Center Applications
Restoring a Database from a Windows Server to the Engine
Changing Engine Settings
Upgrading Extreme Management Center Engine Software

Once you have installed the engine into a rack, you need to connect a monitor and a USB keyboard,
connect the power cord and network cable, and power it on (see Figure 1 on page 9 and Figure 3 on
page 10).

After the engine boots and the engine installation is complete, you must go through the initial
configuration process described in this chapter.

This chapter also includes information on how to change your engine settings following your initial
configuration and how to upgrade the Extreme Management Center application software. For
information on reinstalling the Extreme Management Center engine software, see Reinstalling Engine
Software on page 22.

Pre-Configuration Tasks
Ensure that you have the following information prior to executing the configuration steps in the next
section:

• Engine hostname, IP address, and netmask

• Default gateway IP address

• Name server IP address and domain name

• NIS (Network Information Services) server IP address

• Network Time Protocol (NTP) server IP address

In addition, you need to obtain the appropriate Extreme Management Center software license prior to
launching the Extreme Management Center applications. You are prompted to enter a license when you
launch the application. (When you purchased Extreme Management Center, you received a Licensed
Product Entitlement ID. This Entitlement ID allows you to generate a product license. Refer to the
instructions included with the Entitlement ID that was sent to you.)

Configuring the Engine
After the initial engine installation is complete, use the following steps to configure the engine to run
the Extreme Management Center engine software:

1 Login as root with no password, and press [Enter].

The following screen appears:
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=================================================================

Extreme Networks - Extreme Management Center Suite Engine

Welcome to the Extreme Management Center Engine Setup

=================================================================

Please enter the information as it is requested to continue with the configuration. 
Typically a default value is displayed in brackets. Pressing the [enter] key without 
entering a new value will use the bracketed value and proceed to the next item.
If a default value cannot be provided, the prompt will indicate that the item is either 
(Required) or (Optional). The [enter] key may be pressed without entering data for 
(Optional) items. A value must be entered for (Required) items.
At the end of the setup process, the existing settings will be displayed and 
opportunity will be provided to correct any errors.

=================================================================

Press [enter] to begin setup or CTRL-C to exit:

2 Press [Enter] to begin the setup. The Root Password Configuration screen appears:

=================================================================

Root Password Configuration
=================================================================

There is currently no password set in the system administrator
account (root). It is recommended that you set one that is
active the first time the machine is rebooted.
=================================================================

Would you like to set a root password (y/n) [y]?

Note
You must set a new root password. This new root password is used by the initial user when
logging in to the Extreme Management Center applications.

3 Press [Enter] to set a new root password. Enter the new password as prompted.

Enter new UNIX password:

Retype new UNIX password:

Password updated successfully.

4 After you create the new root password, a screen appears where you can specify a user other than
root to run the Extreme Management Center server, if desired. This user becomes the admin user for
the server.

=================================================================

Select the user to run the server as
=================================================================

Do you want to use an existing user? (y/n) [y]

5 Enter y to use an existing user if you already have a user defined on the machine and enter the user
name. Leave the name set to root if you do not want to specify another user. Accept your selection.
Enter n to create a new "netsight" user (netsight is the user name) and enter the password for this
new user. Re-enter the password and then accept your selection.

Configuration

Extreme Management Center® NMS-A-305 Installation Guide 15



6 In the Extreme Management Center Suite Engine Network Configuration screen, enter the requested
configuration information and press [Enter].

If you plan to use DNS, enter the IP address of the name server. If you are using a name server, enter
a domain name for the engine. If you are using an NIS server to authenticate users logging into the
engine, make sure the NIS domain name is valid or users may not be able to log in to the Extreme
Management Center applications.

=================================================================

Extreme Management Center Suite Engine Network Configuration

=================================================================

Enter the hostname for the engine (Required):
Enter the IP address for <hostname> [192.168.1.10]: 
Enter the IP netmask [255.255.255.0]: 
Enter the gateway address [192.168.1.1]: 
Enter the IP address of the name server (Optional): 
Enter the domain name for <hostname> (Optional): 

Do you want to use NIS (y/n) [n]? y 
Enter the IP address of the NIS server: 
Enter the NIS domain name (Required):

7 In the Confirm Network Settings screen, you can accept the current configuration or modify the
settings.

=================================================================
Confirm Network Settings
=================================================================
These are the settings you have entered. Enter 0 or any key other than a valid 
selection to continue.If you need to make a change, enter the appropriate number now or 
run the /usr/postinstall/dnetconfig script at a later time.
=================================================================
0. Accept settings and continue
1. Hostname:     <hostname>
2. IP address:   192.168.1.10
3. Netmask:      255.255.255.0
4. Gateway:              192.168.1.1
5. Nameserver:   
6. Domain name: <domain name>
7. NIS Server/Domain:
Enter selection [0]:

8 In the SNMP Configuration screen, enter the requested information for each line and press [Enter].

=================================================================
SNMP Configuration
=================================================================
The following information will be used to configure SNMP management of this device. The 
SNMP information entered here must be used to contact this device with remote 
management applications such as Extreme Management Center Console.
=================================================================
Please enter the SNMP user name [snmpuser]:
Please enter the SNMP authentication credential [snmpauthcred]:
Please enter the SNMP privacy credential [snmpprivcred]:

9 In the Configure Date and Time Settings screen, select whether you want to use an external Network
Time Protocol (NTP) server. Enter y to use NTP, and enter your NTP server IP address(es). Enter n to
configure the date and time manually and proceed to step 11.

=================================================================
Configure Date And Time Settings
=================================================================
The engine date and time can be set manually or using an external

Configuration
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Network Time Protocol (NTP) server. It is strongly recommended that
NTP is used to configure the date and time to ensure accuracy of time
values for SNMP communications and logged events. Up to 5 server IP addresses may be 
entered if NTP is used.
=================================================================
Do you want to use NTP (y/n) [y]? y
Please enter a NTP Server IP Address (Required): 144.131.10.120
Would you like to add another server (y/n) [n]? y 
Please enter a NTP Server IP Address (Required): 144.131.10.121 
Would you like to add another server (y/n) [n]? n

10 In the NTP Servers validate selection screen, enter 0 to accept the current settings and proceed to
the Set Time Zone screen in step 13.
=================================================================
NTP Servers
=================================================================
These are the currently specified NTP servers. Enter 0 or any key other than a valid 
selection to complete NTP configuration and continue.
If you need to make a change, enter the appropriate number from the choices listed 
below.
144.131.10.120
144.131.10.121
0. Accept the current settings
1. Restart NTP server selection
2. Set date and time manually
=================================================================
Enter selection [0]: 0

11 If you answered no to using an NTP server to set date and time, set the date and time in the Set Date
and Time screen.
=================================================================
Set Date And Time
=================================================================
The current system date and time is:    Thu Oct 28 09:34:08 2013
Please enter the values for date and time as directed where input is expected in the 
following format:
MM   - 2 digit month of year
DD   - 2 digit day of month
YYYY - 4 digit year
hh   - 2 digit hour of day using a 24 hour clock
mm   - 2 digit minute of hour
ss   - 2 digit seconds
=================================================================
Please enter the month [10]: 
Please enter the day of the month [28]: 
Please enter the year [2013]: 
Please enter the hour of day [09]: 
Please enter the minutes [34]: 
Please enter the seconds [08]: 

12 In the Use UTC screen, select whether you want the system clock to be set to use UTC.
=================================================================
Use UTC
=================================================================
The system clock can be set to use UTC. Specifying no for using UTC,
sets the hardware clock using localtime.
=================================================================
Do you want to use UTC (y/n) [n]?

13 In the Set Time Zone screen, select the appropriate time zone and press [Enter].
=================================================================
Set Time Zone
=================================================================
You will now be asked to enter the time zone information for this system. Available 
time zones are stored in files in the /usr/share/zoneinfo directory. Please select from 
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one of the following example time zones:
1. US Eastern
2. US Central
3. US Mountain
4. US Pacific
5. Other - Shows a graphical list
=================================================================
Enter selection [1]:

14 The Modify Settings screen summarizes the settings you have entered and provides an opportunity
to modify the settings, if desired. Enter 0 to accept the settings.

================================================================
Modify Settings
=================================================================
All of the information needed to complete the installation of the Extreme Management 
Center Engine has been entered. Enter 0 or any key other than a valid selection to 
continue. If you need to make a change, enter the appropriate number from the choices 
listed below.
=================================================================
0. Accept settings and continue

1. Set the root user password

2. Set user to run server as

3. Set hostname and network settings

4. Set SNMP settings

5. Set the system time

6. Modify all settings

Enter selection [0]:

The Extreme Management Center engine software is automatically installed. This could take a few
minutes. When the installation is complete, you’ll see the following screen.

=================================================================

Extreme Networks - Extreme Management Center Suite Engine - Setup Complete

=================================================================

Setup of the Extreme Management Center Engine is now complete. The engine is now 
operational and ready to accept remote connections. Details of the installation are 
located in the /var/log/install directory.

=================================================================

Launching Extreme Management Center Applications
Now that you have configured the Extreme Management Center engine, you are ready to access the
Extreme Management Center Launch Page and run the applications from a remote client machine.

Configuration
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1 Open a browser window on the remote client machine and enter the Extreme Management Center
Launch page URL in the following format:

http://<servername>:8080/ or https://<server-name>:8443/

where <servername> is the Extreme Management Center engine IP address or hostname, and
8080 is the required port number. For example,

http://10.20.30.40:8080/ or https://10.20.30.40:8443/

The Extreme Management Center Launch Page opens.

2 Launch your Extreme Management Center applications by clicking on the names or icons of any of
the listed applications.

A login window appears.

3 Log in as root with the same password you defined in Step 3 or as the user you specified in Step 4.

This is because the Extreme Management Center Server has a single pre-defined user that is the
user who performed the installation. Once the initial user has logged in, additional users can be
defined.

The first time you attempt to launch an Extreme Management Center application, you are prompted for
the license text you received when you generated your Extreme Management Center product license.

For more information on the Extreme Management Center Launch page, access the Online Help by
clicking on ? in top-right corner. In the Online Help Table of Contents, select Installation Guide and then
read the section titled "Remote Client Launch."

Restoring a Database from a Windows Server to the Engine
This section describes several Extreme Management Center configuration changes that are required if
you are moving your Extreme Management Center installation from a Windows platform system to the
engine. The steps are performed after restoring your database to the new engine. (For information on
restoring a database, see the Server Information section in the Extreme Management Center Suite-Wide
Tools User Guide.)

Changing Console
Use the following instructions to change the location of syslog and trap information to the new location
on the engine.

Changing Syslog Location

Change the Syslog Log Manager to point to the new location on the engine. This allows the display of
syslog information in the Syslog Event View tab.

1 From the Console menu bar, select Tools > Alarm/Event > Event View Manager.

2 Click on the Syslog entry under Available Log Managers, and click the Edit button.

The Log Manager Parameters window opens.

3 Change the path in the Log Directory field to /var/log/messages.

4 Change the Pattern to Red Hat LINUX Syslog Pattern.

5 Click OK.

Configuration
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Changing Traps Location

Change the Traps Log Manager to point to the new location on the engine. This allows the display of
trap information in the Traps Event View tab.

1 From the Console menu bar, select Tools > Alarm/Event > Event View Manager.

2 Click on the Traps entry under Available Log Managers, and click the Edit button.

The Log Manager Parameters window opens.

3 Change the path in the Log Directory field to %logdir%/traps.

4 Click OK.

Changing Inventory Manager
If you are using Inventory Manager, you must change the Data Storage Directory path to point to the
new location on the engine. The Data Storage Directory is where all Inventory Manager data is stored,
including capacity planning reports, configuration templates, archived configurations, and property files.

1 Open Management Center and select Administration > Options > Inventory Manager.

2 Select Directory Path in the Data Storage section of the tab.

3 Change the path to the correct new location.

On a default Linux install, the path is: 
/usr/local/Extreme_Networks/NetSight/appdata/InventoryMgr/

4 Click OK.

Changing Engine Settings
Use these steps if you need to change your Extreme Management Center engine settings following your
initial engine configuration.

Changing Basic Network Configuration
To change basic network configuration settings such as hostname and engine IP address, enter the
following command at the engine CLI:

/usr/postinstall/dnetconfig

This starts the network configuration script and allows you to make the required changes. Reboot the
engine for the new settings to take effect.

Changing SNMP Configuration
To change SNMP configuration settings such as system contact, system location, Trap Server, SNMP
Trap Community String, SNMP User, SNMP Authentication, and SNMP Privacy credentials, enter the
following command at the engine CLI:

/usr/postinstall/snmpconfig

This starts the SNMP configuration script and allows you to make the required changes.

Configuration
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Changing Date and Time Settings
To enable or disable NTP for engine date and time, or to manually set the date and time on the engine,
enter the following command at the engine CLI:

/usr/postinstall/dateconfig

This starts the date and time configuration script and allows you to change the settings.

Upgrading Extreme Management Center Engine Software
Upgrades to the Extreme Management Center engine software are available on the NMS web page.

1 On a system with an internet connection, go to the Extreme Management Center Downloads web
page to download the Engine Image 64-bit upgrade file to your system: http://
extranet.extremenetworks.com/downloads/pages/NMS.aspx

2 Enter your email address and password.

You are on the Extreme Management Center page.

3 Click on the Software tab and select a version of Extreme Management Center. Scroll down to see
the engine images.

4 Use FTP, SCP, or a shared mount point, to copy the upgrade file to the Extreme Management Center
engine.

5 SSH to the engine.

6 Cd to the directory where you downloaded the upgrade file.

7 Change the permissions on the upgrade file by entering the following command:

chmod 755 NetSight_Suite_<version>_install.bin

8 Run the install program by entering the following command:

./NetSight_Suite_<version>_install.bin

The upgrade automatically begins.

The Extreme Management Center Server is restarted automatically when the upgrade is complete.
Because your Extreme Management Center engine settings were migrated, you are not required to
perform any configuration on the engine following the upgrade.

Configuration
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3 Reinstalling Engine Software
Use the procedure in this chapter to reinstall the engine software, in the event a software reinstall
becomes necessary. Be aware this procedure reformats the hard drive and reinstalls all the engine
software, the operating system, and all related Linux packages.

Connect a monitor and a USB keyboard to the engine prior to performing these steps.

1 On a Windows platform system, go to the Extreme Management Center web page to download the
Engine Image 64-bit file to your system: http://extranet.extremenetworks.com/downloads/pages/
NMS.aspx

After entering your email address and password, you are on the Extreme Management Center page.
Click on the Software tab and select a version of Extreme Management Center. Scroll down to the
Engine Image 64-bit (ZIP) file and extract the file to a directory on your system.

2 Insert the USB flash drive that came with the engine into the USB port on your system and note the
drive letter it is assigned.

3 Open a command prompt window and cd to the directory where you extracted the file.

4 Type make_disk.bat <drive letter>:.

Note
Because the reinstall procedure reformats the drive, be sure you have specified the correct
drive letter.

5 Press [Enter].

The files are copied to the USB flash drive. When the copy is complete you see the message:
Successfully installed into <drive letter>: Press any key to continue.

6 Remove the USB flash drive from your system.

7 Insert the USB flash drive into a USB port on the engine (see Figure 1 on page 9).

8 Boot the engine from the USB drive using either of these two methods.

• Method 1:

1 Press the power button, and then press F6 to go to the Boot Menu.

2 Select the USB drive on the menu.

3 The engine starts booting from the USB flash drive.

4 When the boot is complete, the Engine Installation screen appears and the installation begins.

• Method 2:

1 Press the power button, and then press F2 to go to the BIOS setup.

2 Use the arrow keys to navigate to the Boot Options menu.

3 Ensure that the USB flash drive is listed as Boot Option #1 at the top.

4 Save changes and exit.

5 The engine starts booting from the USB flash drive.

6 When the boot is complete, the Engine Installation screen appears and the installation begins.

9 After the installation completes, reboot the engine and remove the USB flash drive.

10 Proceed to Configuration on page 14, and follow the instructions for configuring the engine.
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